
Galileo® Print Manager™ 
Troubleshooting Guide 

December 2003 
 

 

 

 

 

 

 

 

 

 

 

 



Contents 

General Application ............................................................................................................ 3 
Printer does not auto wake .......................................................................................................... 3 

Preliminary checks................................................................................................................................. 3 

Firewall issues ....................................................................................................................................... 4 

Changes in Configuration dialog box are not showing in Galileo Print Manager....................... 5 

Adding Galileo Print Manager to the Startup group.................................................................... 6 

Itinerary and Ticket Printing............................................................................................... 6 
Second page of multi-page itineraries prints too low .................................................................. 7 

Preliminary checks................................................................................................................................. 7 

Setting the Forms Length....................................................................................................................... 9 

Missing characters on itineraries or tickets ............................................................................... 11 
Preliminary checks............................................................................................................................... 11 

Correct Device Manager settings......................................................................................................... 11 

No print or serial printer garbling.............................................................................................. 12 
No print................................................................................................................................................ 12 

Garbled print........................................................................................................................................ 12 

Garbled printing on itinerary or ticket after booting ................................................................. 14 
Boot.ini file.......................................................................................................................................... 14 

Wrong date printing on tickets .................................................................................................. 14 

MIR Interface.................................................................................................................... 15 
MIR cable specifications ........................................................................................................... 15 

MIRs are not moving over to the accounting system ................................................................ 15 

Backward compatible control file for MIRs.............................................................................. 16 

Miscellaneous Tips ........................................................................................................... 16 
No device configured for GTID XXXX.................................................................................... 16 

Extra form feed with GIS format and tiny print on Windows 98.............................................. 17 

Windows NT Security/Event Viewer ........................................................................................ 17 

Galileo® Print Manager Troubleshooting Guide (December, 2003)  2



This guide, which contains basic troubleshooting for Galileo® Print Manager, answers the most 
common questions associated with this product.  If you still need to call for assistance, the person 
assisting you may walk you through the steps in this document to resolve your problem.  For 
information on how to get started with Galileo Print Manager™ software, please refer to Galileo 
Print Manager Quick Reference.   

This guide includes the following sections: 

• General Application  

• Itinerary and Ticket Printing 

• MIR Interface 

• Miscellaneous Tips 

General Application 
This section includes the following problems and their solutions: 

• Printer does not auto wake 

• Changes in Configuration dialog box are not showing in Galileo Print Manager 

• Adding  to the Startup menu 

Printer does not auto wake 
This section includes: 

• Preliminary checks 

• Firewall issues 

Preliminary checks 
• Make sure the Galileo Print Manager application is open and running. 

• When initially open or after five minutes of inactivity, it is normal for the GTIDs to go into a 
sleep mode, as shown by red Xs in the GTID column and a status message of, “Listening for 
connection...”, on the lower left side of the following screen. 

 
Continued on next page 
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Preliminary checks (Cont.) 
The GTIDs should automatically “wake” when a ticket, itinerary, P-, OSDP, or MIR is 
issued.  The status should change to “Registered”, as shown on the following screen. 

 
• If the status message is “Registered”, but nothing is printing: 

1. Close and re-open Galileo Print Manager.  Then, from the Print Manager Tools menu, 
click Connect Now. 

2. If that does not work, close all applications, reboot the PC, re-open Galileo Print 
Manager, and then, from the Tools menu, click Connect Now. 

• The Galileo Print Manager workstation must have a fixed IP address. 

• If you are running FocalpointNet™, the Galileo Print Manager should either be installed on 
the WinGate or single-user workstation. 

• If the printer continuously fails to auto wake, verify with the Apollo® Help Desk that the 
FPM, CDS settings, and GTIDs have been set up correctly in the Apollo database.  

Firewall issues 
If you are running Galileo Print Manager behind a firewall, the firewall needs to be configured 
with specific port settings. 

Example: 
5067 / UDP Traffic / Inbound Only 

5068 / UDP Traffic / Outbound Only 

5069 / TCP Traffic / Inbound Only (FPM Requirement) 

ANY / TCP Traffic / Inbound Only (FPM Requirement) 

Note:  Go to http://support.galileo.com/aps/files/TSD-FirewallSpecsProd.htm for “Firewall & 
Proxy Specifications”, which provides a detailed explanation on setting configurations for a 
successful operation behind a firewall.  It also includes information regarding route add 
statements, which are sometimes required. 
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Changes in Configuration dialog box are not showing in Galileo Print 
Manager 
The Galileo Print Manager application must be closed before you add or configure a new device 
in the Configurations area.  This is the main reason that configuration changes may not show in 
the Print Manager window. 

Sometimes all that is needed is to close and re-open Print Manager or reboot the PC.  If that does 
not work, close Print Manager and use the following steps to go back to the Configurations area, 
and then delete and re-add the device. 

1. To delete and re-add the device in the Configurations area: 

a. From the Start menu, click Programs, Galileo Print Manager, and Configurations. 

The Configuration dialog box appears. 

b. Locate the device that does not show when the Galileo Print Manager is launched. 

c. Right-click the device, and then click Delete. 

d. Click Yes to delete. 

e. To re-add the device, from the File menu, click New, Device. 

f. Follow the steps on the wizard to add the device. 

g. Close the Configuration dialog box. 

2. To verify that the changes appear, re-open Galileo Print Manager. 

3. If the changes are still not appearing, uninstall and then reinstall Galileo Print Manager. 

Note:  Refer to online help for specific instructions on uninstalling. 
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Adding Galileo Print Manager to the Startup menu 
This section does not apply to FocalpointNet™ installations. 

During the installation of Galileo Print Manager, you are given the option to add Galileo Print 
Manager to the startup group.  This is recommended so the application is automatically launched 
if you must restart the workstation. 

The following dialog box shows the Add Galileo Print Manager to the Startup menu. 

 
To manually add Galileo Print Manager to the Startup menu (Win 9x), follow these steps. 

1. Right-click the Taskbar (at the bottom of the screen) and then click Properties. 

The Taskbar Properties dialog box appears. 

2. Click the Start Menu Programs tab. 

3. Click Add. 

The Create Shortcut wizard appears. 

4. Click Browse and go to \My Documents\Focalpoint PM\. 

5. In the File Name box, type: host.gsa 

6. Click Open, and then click Next. 

7. Select the Startup folder and click Next. 

Note:  To find the Startup folder, you may need to scroll. 

8. For the shortcut name, type: Print Manager. 

9. Click finish, and then OK. 

Itinerary and Ticket Printing 

This section includes the following problems and their solutions: 

• Second page of multi-page itineraries prints too low 

• Missing characters on itineraries or tickets 

• No print or serial printer garbling 

• Garbled printing on itinerary or ticket after booting the PC that has serial printers attached 

• Wrong date printing on tickets 
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Second page of multi-page itineraries prints too low 
This section includes: 

• Preliminary checks 

• Setting the form length 

Preliminary checks 
• Verify that the correct form length is set on the printer. 

Example: 

For this setting: Do this: 

TI-810 1. Set the form length dial to 11 or 14 inches (and not PROG). 

2. Turn power off, and then on. 

Lexmark or IER Set the menu form length to 66 for 11 inches or 84 for 14 
inches. 

• Use the “generic/text only” print driver. 

• Set the page length for the print driver to letter or legal to match the itinerary stock (11 or 14 
inches). 

• If you are using a Design Your Own (DYO) itinerary, configure GPM to use the DYO 
itinerary driver. This driver allows you to control (add or subtract) line feeds to correct 
printing alignment problems with multi-page itineraries.  

Step 1 Launch The Galileo Print Manager Configuration screen (Start, all programs, Galileo 
Print Manager, Configurations). 

Note: You can identify whether or not you are currently using the DYO Itinerary driver by 
viewing its icon (shows red DYO on an itinerary printer). If the DYO Itinerary print driver is 
already added, Right-click and select properties, click the print tab, then skip to step 9. 
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Step 2 Delete the current Itinerary driver. Right-Click the current itinerary driver and select      
delete. Click yes on the confirm delete prompt. 

Step 3 Click the File Menu and select New, then Device. 

 
Step 4 Type the device number (in this example, the itinerary is the second GTID). 

Step 5 Click the down arrow for Printer Type and select “DYO Itinerary”. 

Step 6 Click Next. 

 
Step 7 Click to select the itinerary printer (in the example, a TI810). 

Step 8 Uncheck the “Use the Default printer” if not using the Windows default printer. 

Step 9 Click the “Add/Delete extra lines per page” option to either add or subtract line feeds 
after the first itinerary page prints. Adjust as necessary. For example: 

 +01 will move the print on the itinerary up one line.  

  -01 will move the print on the itinerary down one line. 

Step 10 Click Next. 

Step 11 Click Next at the “Spooled device” screen. 

Step 12 Click No (or Yes) to print a test page, then Click Finish. 
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• If still having problems with the second page printing down a line, move the DYO “EOF 
label” up at least one line.  For example, on an 11-inch, change EOF from 66 to 65. 

Setting the Form Length 
This section includes procedures to set the form length for: 

• Windows 95 and 98 

• Windows 2000 and XP 

 

Windows 95 and 98 

1. From the Start menu, click Settings, Printers. 

2. Right-click the desired printer. 

The Properties dialog box appears. 

 
3. In the Paper size section of the Paper tab, select the form length. 

• For 11 inch, click Letter. 

• For 14 inch, click Legal. 

4. On the printer dial or menu, set the form length.  For example: 

Set this printer: To this length: 

TI-810 11 or 14 

Lexmark or IER 66 lines or 84 lines 

 

 
Continued on next page 
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Windows 2000 and XP 

The form length needs to be set in two areas: 

First area: 

1. Do one of the following: 

• For Windows 2000, from the Start menu, click Settings, Printers. 

• For Windows XP, from the Start menu, click Printers and Faxes. 

2. Right-click the desired printer and then click Properties. 

3. Click the Advanced tab on the top of the page. 

4. Click Printing Defaults. 

5. Click the Paper/Quality tab. 

6. On the Paper Source box, select Continuous Feed with break. 

7. Click OK. 
 

Windows 2000 and XP 

Second area: 

1. Do one of the following: 

• For Windows 2000, from the Start menu, click Settings, Printers. 

• For Windows XP, from the Start menu, click Printers and Faxes. 

2. Right-click the desired printer and then click Properties. 

3. Click Printing Preferences at the bottom of the page. 

4. Click the Paper/Quality tab. 

5. On the Paper Source box, select Continuous Feed with break. 

6. Click OK. 
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Missing characters on itineraries or tickets 
This section includes: 

• Preliminary checks 

• Correct Device Manager settings 

Preliminary checks 
• Lower the baud rate to 4800 on both the Windows port settings and the printer.  If that does 

not correct the problem, lower the baud rate to 2400. 

• For tickets, if you have Quicken or Quickbooks loaded on your Galileo Print Manager 
workstation, there is a file conflict.  Please contact the Apollo Help desk for instructions on 
how to remove this file. 

Correct Device Manager settings  
1. From the Start menu, click Setting, Control Panel, and then double-click System. 

The System Properties dialog box appears. 

2. Click the Device Manager tab. 

3. Right-click the port that you are using for the printer and select Properties. 

The Port Properties dialog box appears. 
Continued on next page 
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Correct Device Manager Settings (Cont.) 
4. Click the Advanced button. 

The Advanced Port Settings dialog box appears. 

 
5. Clear the check from the Use FIFO… checkbox. 

6. Set Receive Buffer and Transmit Buffer to the lowest setting. 

7. Click OK. 

No print or serial printer garbling 
This section includes: 

• No print 

• Garbled print 

No print 
1. Ensure that the printer is online. 

2. Ensure that you can print a test page: 

From the Context menu of the print device, right-click the printer icon in the configuration 
window. 

Note: Certain print devices do not successfully complete a test.  For example, the print test 
does not work for the ADP 2200, 3000, 3117. 

Garbled print 
The Windows serial port settings must match the printer serial settings. 

This section includes: 

• Windows serial port settings 

• Printer serial port settings 
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Windows serial port settings 

Setting: Value:  

Bits per second 9600 

Data bits 7 or 8 
Note: This can be 7 or 8 depending on the printer, but the port setting and 
printer serial settings must match. 

Parity Odd 

Stop bits 1 

Flow control Hardware 

The following Properties dialog box shows the correct settings. 

 

Printer serial settings 

If using a serial printer with a menu, set the serial settings the same as the Windows serial port 
settings, as specified in the previous section.  For printers that use switch settings to set the serial 
options, use the guidelines in the following table to set the switches. 

Printer:  Switch Location: Switch Setting: 

TI-810 Front of printer Switch 1 – On 

Switches 2-7 - Off 

Lexmark Back of printer (serial adapter 
cable) 

Switch 6 – On 

All other switches – Off  
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Garbled printing on itinerary or ticket after booting the PC that has serial 
printers attached 
During start-up, Windows NT sends a detection signal to each COM port in order to recognize 
hardware attached to that port.  If a ticket or itinerary printer is connected to a COM port, the 
following characters are printed during the initialization of the ports: xx-xfs. 

Note:  Since Windows NT is not a standard Galileo platform, this section is informational only 
and not currently supported by the Apollo Help Desk. 

Boot.ini file 
If the printer is a TI-810, the characters are buffered at initialization and printed when the first 
ticket is printed.  To prevent this from happening, use the /NoSerialMice switch in the Boot.ini 
file. 

Boot.ini is a hidden system file found in the root of your NT boot drive.  Changing the file 
attributes is required before editing the file. 

To change the attributes, use the following formats: 

To: Use this format: 

Remove the attributes ATTRIB BOOT.INI –s –h 

Replace the attributes ATTRIB BOOT.INI +s +h 

 

You can use multiple /NoSerialMice switches.  The format is: 
/NoSerialMice=[COMx | COMx, COMy, COMz...] 

If: Then serial mouse detection is: 

/NoSerialMice is specified without parameters Disabled on all the serial ports. 

/NoSerialMice=COMx is specified Only disabled on COMx. 

/NoSerialMice=COMx,COMy,COMz.. is 
specified 

Disabled on each of the specified ports. 

Wrong date printing on tickets 
The wrong date can print on a ticket even though the date shows correctly when displayed in 
Focalpoint.  This may be caused by a third-party software driver (MRTRATE.VXD, a virtual 
device driver) that is not part of any Galileo software and has no relation to any Galileo 
functionality. 

This file may also cause problems and fatal exception errors with several commercial printers 
unrelated to Galileo ticket printing.  The file, MRTRATE.VXD is delivered to a PC via Quicken 
2000 Release 3, Quick Books, or Earthlink ISP software (most recently Earthlink 5.0).  A fix is 
available from the Apollo Help Desk. 
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MIR Interface 

This section includes the following problems and their solutions: 

• Machinable Interface Record (MIR) cable specifications 

• MIRs are not moving over to the accounting system 

• Backward compatible control file for MIRs 

MIR cable specifications 
To see details on the Machinable Interface Record (MIR) cable specifications on the ACSC Web 
site, follow these steps. 

1. Go to the Apollo Customer Support Center Web site:  http://support.galileo.com/acsc  

2. On the Welcome screen, enter your pseudo city code and PIN number. 

The ACSC Site menu appears. 

3. In the Troubleshooting section, click Acctg/MIR Cable Specifications. 

4. Click the link corresponding to your backroom accounting system.  

MIRs are not moving over to the accounting system 
Determine whether your accounting system requires that the option “Append end of text (ETX) 
character” be selected.  By selecting this option, an ETX character (HEX (03)) is appended to the 
data stream. 

Note:  GlobalWareSM customers should check this option. 

To select the ETX character: 

1. Open the Galileo Print Manager Configuration dialog box. 

2. Right-click the MIR device and click Properties. 

3. Click the Port tab. 

The MIR to Serial Port dialog box appears. 

 
4. Check the box next to Append ETX to Data Stream. 
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Backward compatible control file for MIRs 
During the setup of a “MIR to Disk” device, there is a setting option of “Backward compatible 
Control File”.  This controls whether the mirfile.txt shows the last MIR file that was created or 
the next one to be created. 

The following table provides guidelines for this option.  For further information, contact your 
provider. 

To show the: Do this: Recommended for these systems: 

Last MIR file to be created Check the box. Trams and Travcom 

Next MIR file to be created Clear the check. GlobalWare 

Miscellaneous Tips 

This section includes the following problems and their solutions: 

• No device configured for GTID XXXX 

• Extra form feed with GIS format and tiny print on Windows 98 

• Windows NT security/event viewer 

 

No device configured for GTID XXXX 
No print data is received. 

Microsoft Internet Explorer version 5.0 or higher is required on Windows 98 First Edition, 
Windows 2000, Windows ME and Windows NT 4.0 even if the Galileo Print Manager 
workstation does not have Internet access. 

To determine the Microsoft Internet Explorer version: 

1. To open Microsoft Internet Explorer, double-click the icon. 

2. From the Help menu, click About. 
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Extra form feed with GIS format and tiny print on Windows 98 
In the Windows Printers area, add and configure the printer using the Generic/Text Only print 
driver as shown in the following dialog box. 

 

Windows NT Security/Event Viewer 
It is recommended that when running Focalpoint® Print Manager on Windows NT, the following 
precautions should be taken. 

The NT workstation or NT server should be given and operate with local administrative authority 
for the machine itself.  If this isn’t done, NT security issues take place when Galileo Print 
Manager updates Event Viewer. 
 

 

 

 

 
Acknowledgement: 

This Quick Reference was developed by Galileo International, Customer and Sales Education. 

For questions or comments, please send a message to customer.education@galileo.com 
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